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Before You Begin 

Estimated time to complete this lab 
45 minutes 

Objectives 
After completing this lab, you will be able to: 

·  Manage a Microsoft® SQL Server® Analysis Services instance and database. 

·  Secure Analysis Services. 

·  Monitor Analysis Services performance. 
 

Prerequisites 
Before working on this lab, you must have: 

·  A general understanding of Analysis Services concepts including cubes, dimensions, 
and partitions. 

·  Familiarity with SQL Server Management Studio. 
 

Lab Setup 

Lab scenario 
Adventure Works Cycles, a bicycle manufacturing company, wants to use 
multidimensional analysis to better understand its customer base. Over time, the company 
has collected information about past customers and sales. It now wants to use this 
information to gain insights about its customers. The company has arranged this data into 
an Online Analytical Processing (OLAP) database. It plans to use this OLAP database to 
analyze past and present business trends. You have been hired to help implement the 
management and maintenance of this new database. 

 

Virtual PC 
This lab makes use of Microsoft Virtual PC 2007, which is an application that allows you 
to run multiple virtual computers on the same physical hardware. During the lab, you will 
use a virtual machine running Windows Server® 2003. 

Before you start the lab, familiarize yourself with the following basics of Virtual PC: 

·  To switch the focus for your mouse and keyboard to the virtual machine, click inside 
the virtual machine window. 

·  To remove the focus from a virtual machine, move the mouse pointer outside the 
virtual machine window. 

·  To mimic the CTRL+ALT+DELETE key combination inside a virtual machine, use 
RIGHT-ALT+DELETE. In Virtual PC, the RIGHT-ALT key is called the host key. 
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·  To enlarge the size of the virtual machine window, drag the lower-
right corner of the window as seen in the screenshot. 

 

·  To switch to and from full-screen mode, press RIGHT-ALT+ENTER. 
 

Computers in this lab 
This lab uses one computer as described in the following table. Before you begin the lab, 
you must start the virtual machines and then log on to the computer. In each exercise, you 
only have to start the virtual machine that is needed. 

Virtual Machine Computer Name User Name Password 

SQL Server 2008 HOLs MIAMI Student Pa$$w0rd 

Start the virtual machine 
1. Launch Microsoft Virtual PC from the Start menu or desktop. If the Virtual PC 

console does not appear, double-click its icon in the notification area. 

2. Select SQL Server 2008 HOLs, and then click Start. 

3. When the virtual server is running, in the virtual server window, on the Action menu, 
click Ctrl+Alt+Del  (or press RIGHT-ALT+DELETE on your keyboard) to send a 
CTRL+ALT+DEL sequence to the logon dialog box within the virtual server window. 

4. Type the following information, and then click OK: 

·  User name: Student 

·  Password: P@ssw0rd 
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Exercise 1: Managing Analysis Services 
In this exercise, you will use SQL Server Management Studio, which is the central 
management tool for all SQL Server technologies, to manage your Analysis Services 
instance and databases. SQL Server Management Studio provides an intuitive interface 
that enables administrators to perform maintenance tasks such as connecting to multiple 
Analysis Services instances, managing configuration properties, managing partitions and 
aggregation designs, and backup and restore processes for Analysis Services. 

 

Set up the Adventure Works OLAP database and securi ty principals 
1. In Windows Explorer, navigate to the C:\SQLHOLs\Managing Analysis 

Services\Starter folder. 

2. Double-click Setup.cmd. This script deploys an Analysis Services database and 
creates the Microsoft Windows® user accounts required to complete the lab. 

3. When the Command prompt window closes, close Windows Explorer. 
 

Connect to the default instance of Analysis Service s 
1. Click Start, point to All Programs, point to Microsoft SQL Server 2008, and then 

click SQL Server Management Studio. 

2. In the Connect to Server dialog box, in the Server type drop-down menu, select 
Analysis Services, in the Server name box, type (local), and then click Connect. 

Note:  In Object Explorer, you can click the Connect  button to connect to additional 
Analysis Services instances and to the Database Engine (for relational databases), 
Reporting Services, Integration Services, and SQL Server Compact Edition. 

 

Modify configuration properties of an Analysis Serv ices instance 
In this procedure, you will change the default backup folder used by the (local) 
instance of Analysis Services so that by default, backup files are saved in a folder in 
the C:\SQLHOLS folder tree. You will also change the number of queries that SQL 
Server Analysis Services logs for usage-based optimization from the default value of 
one query in ten to one query in two. 

1. In Object Explorer, right-click the (local) Microsoft Analysis Services server, and 
then click Properties. 

2. In the Analysis Server Properties dialog box, on the General page, in the 
BackupDir  row, click the Value column, and then click the button that appears on 
the right side of the cell. 

3. In the Browse for Remote Folder dialog box, in the Selected Path box, type 
C:\SQLHOLS\Managing Analysis Services\Starter and then click OK. 
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4. Note that the Current Value (in the Analysis Server Properties dialog box, on the 
General page) has not been updated. 

5. In the Analysis Server Properties dialog box, on the General page, in the 
Log\QueryLog\QueryLogSampling row, click the Value column, change the Value 
to 2, and then click OK. This will cause Analysis Services to log one in every two 
queries. On a test server with a low volume of querying, the new sampling rate will 
provide a more useful log. 

6. In the Restart Required message, click OK. 

7. In Object Explorer, right-click the (local) Analysis Services server, and then click 
Properties. 

8. Notice that the Current Value of BackupDir  still has not been updated. You must 
restart the Analysis Services service for this change to take effect. The 
Log\QueryLog\QueryLogSampling value does not require you to restart the service, 
and the current value has been updated to 2. 

9. In the Analysis Services Properties dialog box, click Cancel to close the dialog box. 

10. In Object Explorer, right-click the (local) Analysis Services server, and then click 
Restart. 

11. Click Yes to confirm that you want to restart the service. 

12. In Object Explorer, right-click the (local) Analysis Services server, and then click 
Properties. 

13. Notice that the Current Value of BackupDir  has been successfully updated. 

14. In the Analysis Services Properties dialog box, click Cancel to close the dialog box. 
 

Create an aggregation design for a partition 
In this procedure, you will use the Aggregation Design Wizard to examine a partition 
of a cube and design aggregations that can be pre-calculated when the cube is 
processed to improve query performance. 

1. In Object Explorer, expand the Databases folder, expand Adventure Works OLAP, 
expand Cubes, expand Adventure Works Cube, expand Measure Groups, expand 
Internet Sales, and then expand Partitions. 

2. Right-click the Internet Sales partition, and then click Design Aggregations. 

3. On the Welcome to the Aggregation Design Wizard page, click Next. 

4. On the Review Aggregation Usage page, review the default information, and then 
click Next. 
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5. On the Specify Object Counts page, click Count. This will cause the wizard to 
count the number of objects in the partition to estimate storage requirements. When 
the count is complete, click Next. 

6. On the Set Aggregation Options page, select Performance gain reaches, note that 
the default target for the performance increase is 30 percent, and then click Start. 
The wizard analyses the partition and designs appropriate aggregations for the target 
performance improvement. When the aggregations design is complete, click Next. 

7. On the Completing the Wizard page, verify that Save the aggregations but do not 
process them is selected, and then click Finish. 

Note: By using the Aggregation Design Wizard, you have identified aggregations 
that SQL Server Analysis Services can perform on the data when the partition is 
processed to improve query performance by 30 percent. You can also design 
aggregations based on usage. 

 

Backup and restore an Analysis Services database 
1. Right-click the Adventure Works OLAP database, and then click Back Up. 

2. In the Backup Database dialog box, on the General page, verify that the Database 
box contains the text Adventure Works OLAP, and then verify the Backup file box 
contains the text Adventure Works OLAP.abf. 

3. Select the Allow file overwrite  check box, verify that the Apply compression and 
Encrypt backup file check boxes are selected, type Pa$$w0rd in both the Password 
and Confirm Password boxes, and then click OK. 

Note:  The database will be backed up to the default directory defined earlier in this 
exercise. You can click the Browse  button of the Backup File  box to select a 
different backup location. 

When the backup is complete, the Backup Database dialog box will close. 

4. In Object Explorer, right-click the Databases folder, and then click Restore. 

5. In the Restore Database dialog box, on the General page, enter the following 
information, and then click OK. 

·  Restore database: Adventure Works OLAP Test 

·  From backup file: C:\SQLHOLS\Managing Analysis Services\starter\Adventure 
Works OLAP.abf 

·  Include security information: selected 

·  Password: Pa$$w0rd 
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Note:  This process creates a new database named Adventure Works OLAP 
Test . This enables you to test the restore process without overwriting the existing 
Adventure Works OLAP database. 

6. When the restore is complete, the Restore Database dialog box will close. 

7. Right-click the Databases folder, and then click Refresh. Verify that the Adventure 
Works OLAP Test database has been created. 

8. Keep SQL Server Management Studio open for the next exercise. 
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Exercise 2: Managing Security 
In this exercise, you will use SQL Server Management Studio to apply security measures 
to your Analysis Services environment. SQL Server Analysis Services has a 
comprehensive security environment that enables administrators to fine-tune server and 
database security. You will use these security features to apply changes to the service 
account for Analysis Services, create an administrator account to manage the Analysis 
Services environment, and create user-defined roles to manage access to secure data 
within a cube. 

 

Configure the Analysis Services service account 
1. Click Start, point to All Programs, point to Microsoft SQL Server 2008, point to 

Configuration Tools, and then click SQL Server Configuration Manager. 

2. In the navigation pane, click SQL Server Services, in the Details pane, right-click 
the SQL Server Analysis Services (MSSQLSERVER) service, and then click 
Properties. 

3. In the Properties dialog box, verify that This account is selected, 
type .\AnalysisService in the Account Name box, type Pa$$w0rd in the Password 
and Confirm password boxes, and then click OK. 

4. In the Confirm Account Change message, click Yes to allow the service to be 
restarted. The Properties dialog box will close automatically after the service has 
successfully restarted. 

5. Close SQL Server Configuration Manager. 

Note: By configuring Analysis Services to run with a specific user account, you can 
ensure that the service uses an account that has only the permissions and system 
rights that it requires. This approach helps to minimize security risks. 

 

Add a user to the server role 
1. In SQL Server Management Studio, in Object Explorer, right-click the (local) 

Analysis Services instance, and then click Properties. 

2. In the Analysis Server Properties dialog box, in the Select a page area, click 
Security. 

3. In the Members of server role area, click Add. 

4. In the Select Users or Groups dialog box, in the Enter the object names to select 
box, type ASAdmin and then click Check Names. 

5. Verify that the name is resolved to MIAMI\ASAdmin , and then click OK. 

6. On the Analysis Server Properties page, click OK. 
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By adding the ASAdmin user account to the server role, you have granted it all of the 
permissions required to manage the Analysis Services instance and databases. In the 
following steps, you will verify that this account has administrative privileges by 
using it to restart the Analysis Services service. 

7. Click Start, point to All Programs, point to Microsoft SQL Server 2008, point to 
Configuration Tools, right-click SQL Server Configuration Manager, and then 
click Run as. 

8. Run the application as the following user: 

·  User name: ASAdmin 

·  Password: Pa$$w0rd 

9. In the navigation pane, click SQL Server Services, in the Details pane, right-click 
SQL Server Analysis Services (MSSQLSERVER), click Restart, and then verify 
that the service has successfully restarted. 

10. Close SQL Server Configuration Manager. 
 

Configuring user access to an Analysis Services dat abase 
1. Return to SQL Server Management Studio. 

2. In Object Explorer, expand Databases, expand Adventure Works OLAP, right-
click Roles, and then click New Role. 

3. In the Create Role dialog box, on the General page, in the Role name box, type 
VPSalesRole 

4. In the Select a page pane, click Membership. 

5. On the Membership page, click Add to specify the users and groups for this role. 

6. In the Select Users or Groups dialog box, click Object Types. 

7. In the Object Types dialog box, verify that the Built-in security principals  and 
Users check boxes are selected, select the Groups check box, and then click OK. 

8. On the Select Users or Groups page, in the Enter the object names to select box, 
type VPSales and then click Check Names. 

9. Verify that the name is resolved to MIAMI\VPSales , and then click OK. 

10. In the Select a page pane, click Cubes. 

11. On the Cubes page, change the Access column to Read for Adventure Works Cube, 
and then click OK. 

Note: This enables users in the VPSales role to read data in the Adventure 
Works  cube. 
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12. In Object Explorer, right-click Roles, and then click New Role. 

13. In the Create Role dialog box, on the General page, in the Role name box, type 
EuroSalesMgrsRole 

14. In the Select a page pane, click Membership. 

15. On the Membership page, click Add to specify the users and groups for this role. 

16. In the Select Users or Groups dialog box, click Object Types. 

17. In the Object Types dialog box, verify that the Built-in security principals  and 
Users check boxes are selected, select the Groups check box, and then click OK. 

18. In the Select Users or Groups dialog box, in the Enter the object names to select 
box, type EuropeanSalesMgrs and then click Check Names. 

19. Verify that the name is resolved to MIAMI\EuropeanSalesMgrs, and then click OK. 

20. In the Select a page pane, click Cubes. 

21. On the Cubes page, change the Access column to Read for the Adventure Works 
Cube. 

Note: This enables users in the EuropeanSalesMgrs  role to read data in the 
Adventure Works cube. 

22. In the Select a page pane, click Dimension Data. 

23. On the Dimension Data page, in the Dimension box, select Sales Reason, and then 
click OK. 

24. On the Basic tab, in the Attribute Hierarchy  drop down list, click Sales Reason 
Type, and then click Deselect all members. Then select only the following 
members: 

·  Marketing 

·  Promotion 

Note: This prevents users in the EuropeanSalesMgrs  role from viewing data for 
the Other  sales reason type in the Sales Reason Type  hierarchy. 

25. In the Select a page pane, click Cell Data. 

26. On the Cell Data page, in the Cube box, select the Adventure Works Cube, click 
Enable read permissions, and then type the following MDX query in the Allow 
reading of cube content box. 
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Note:  You can copy this script from C:\SQL Hands-on-Labs\Managing Analysis 
Services\Starter\CellDataMDX.txt. This restricts users in the EuropeanSalesMgrs  
role to viewing sales quotas for Europe. 

27. Click OK to close the Edit Role dialog box. 
 

Test user access to an Analysis Services database 
1. In Object Explorer, expand Cubes, right-click the Adventure Works Cube, and then 

click Browse. 

2. On the Adventure Works Cube [Browse] tab, click the Change User icon. 

3. In the Security Context dialog box, click Roles, select the VPSalesRole role, verify 
that no other roles are selected, click OK, and then click OK to change the security 
context. 

Note the information line below the toolbar stating that you are using the 
VPSalesRole credentials. 

4. In the Metadata pane, expand Measures, expand Internet Sales, expand Sales, drag 
Internet Sales – Sales Amount to the result pane on the right, and then drop it in the 
Drop Totals or Detail Fields Here area (alternatively, right-click Internet Sales – 
Sales Amount, and then click Add to Data Area). 

5. In the Metadata pane, expand the Sales Reason dimension, drag Sales Reason Type 
to the result pane, and then drop it in the Row Fields Here area (alternatively, right-
click the Sales Reason Type attribute hierarchy, and then click Add to Row Area). 

Verify that the VPSalesRole role can view sales amounts for the Marketing , 
Promotion, and Other sales reason types. 

6. Right-click the result area, and then click Clear Results (alternatively, on the toolbar, 
click Clear Results) to clear all data from the browser. 

7. In the Metadata pane, expand Measures, expand Sales Quotes, right-click Sales 
Amount Quota, and then click Add to Data Area. 

8. In the Metadata pane, expand the Sales Territory dimension, right-click the Sales 
Territories  hierarchy, and then click Add to Row Area. 

Verify that the VPSalesRole role can view sales quotas for all territories. 

9. Click the Change User icon. 

10. In the Security Context dialog box, in the Roles drop-down list, clear the 
VPSalesRole role, select EuroSalesMgrsRole, verify that no other roles are selected, 
click OK, and then click OK to close the Security Context dialog box. 

Note the information line below the toolbar stating that you are using the 
EuroSalesMgrsRole credentials. 
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11. In the Metadata pane, expand Measures, expand Internet Sales, expand Sales, 
right-click Internet Sales – Sales Amount, and then click Add to Data Area. 

12. In the Metadata pane, expand the Sales Reason dimension, right-click the Sales 
Reason Type attribute hierarchy, and then click Add to Row Area. 

Verify that the EuroSalesMgrsRole role can view sales amounts for the Marketing  
and Promotion but not the Other sales reason type. 

13. On the toolbar, click Clear Results to clear all data from the browser. 

14. In the Metadata pane, expand Measures, expand Sales Quotes, right-click Sales 
Amount Quota, and then click Add to Data Area. 

15. In the Metadata pane, expand the Sales Territory dimension, right-click the Sales 
Territories  hierarchy, and then click Add to Row Area. 

Verify that the EuroSalesMgrsRole role can view sales quotas for Europe but not for 
other territories. 

16. Keep the cube browser window open for the next exercise. 
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Exercise 3: Monitoring Performance 
In this exercise, you will use dynamic management views (DMVs) to monitor connection 
and resource statistics for Analysis Services. The ability to monitor Analysis services 
statistics can help you to troubleshoot and optimize Analysis Services performance. 

View Analysis Services connection and session infor mation 
1. In SQL Server Management Studio, on the File menu, point to New, and then click 

Analysis Services MDX Query (alternatively, on the toolbar, click New Query). 

2. On the Connect to Analysis Services dialog box, click Connect. 

3. On the toolbar, in the Available Databases list, ensure that the Adventure Works 
OLAP database is selected. 

4. Type and execute the following command, and then scroll through the results and 
review all of the rows with a TABLE_NAME value that begins with DISCOVER_ . 
This query provides you with the DMVs available. 

� % ���&�'"!��(�������)*��+ ��,���
���

Note: These DMVs give you the flexibility to retrieve performance statistics from 
the server. You can write custom applications or use SQL Server Reporting 
Services to generate reports to gather and view the information that you need to 
troubleshoot and optimize your Analysis Services environment. 

5. On the Query page, type the following command, and then click Execute. 

� % ���&�'"!��(�������-����.��,������������

6. View the query results. Adjust the column width of the fifth column from the left 
(CONNECTION_HOST_APPLICATION ) to view the full application name for 
each connection. Notice that the result differentiate between SQL Server 
Management Studio Queries and SQL Server Management Studio. 

Note:  Values such as the CONNECTION_LAST_COMMAND_START_TIME, 
CONNECTION_LAST_COMMAND_END_TIME, and 
CONNECTION_LAST_COMMAND_ELAPSED_TIME_MS can help you find long 
running or problematic queries. 

7. Close the Adventure Works Cube [Browse] window that you left open at the end of 
the previous exercise. 

8. On the MDXQuery1 tab, re-execute the query from step 5 (SELECT * FROM 
$system.discover_connections), and notice that the SQL Server Management Studio 
connections are no longer present. Make a note of the current CONNECTION_ID 
values. 

9. Minimize SQL Server Management Studio. 
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10. Click Start, point to All Programs, point to Microsoft Office, and then click 
Microsoft Office Excel 2007. 

11. On the Excel ribbon, click the Data tab. 

12. On the Data tab, in the Get External Data section, click From Other Sources, and 
then click From Analysis Services. 

13. On the Connect to Database Server page, in the Server name box, type (local) and 
then click Next. 

14. On the Select Database and Table page, in the Select the database that contains 
the data you want box, select the Adventure Works OLAP database, click the 
Adventure Works Cube cube, and then click Next. 

15. On the Save Data Connection File and Finish page, click Finish. 

16. On the Import Data  page, review the default settings, and then click OK. 

17. In the PivotTable Field List, under Internet Sales, expand Sales, and then select the 
check box for Internet Sales-Sales Amount. 

18. In the PivotTable Field List, under Product, select the check box for Product 
Categories. 

19. Minimize Microsoft Office Excel®, and then maximize SQL Server Management 
Studio. 

20. On the MDXQuery1 tab, re-execute the query from step 5 (SELECT * FROM 
$system.discover_connections), and then document the CONNECTION_ID of the 
new connection created by Excel. 

21. Below the existing query, type the following query. 
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22. Highlight the query that you just entered, and then click Execute. 
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23. Review the output for the row where the session_connection_id matches the number 
that you documented in step 20. Note that these results include useful diagnostic 
information such as the username, last command, and CPU time for each connection. 

Note:  A session_status  of 1 represents a session with an active query at the time 
that the report is run. 

 

View Analysis Services object information 
1. Open a new MDX Query tab, and then connect to the (local) server. 

2. Type and run the following command to view the memory usage for each object in 
the database. 

� % ���&�'"!��(�������-����.��,��0���,������,���1��

3. Type and run the following command to view the activity for each object in the 
database. 

� % ���&�'"!��(�������-����.��,��0���,����.����

4. Close SQL Server Management Studio and Microsoft Office Excel 2007. Do not save 
any files. 

5. Close Virtual PC and discard changes. 
 

 


